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1.1 - INTRODUCTION

Using any e-mail system on the road can occasionally be a frustrating experience Fortunately the techies in

Greenpeace have created some new software called GreenConnect that is reliable and easy to use. (At the bot­

tom of page 14, you can see what the current, main screen of GreenConnect looks like.) Thanks to global coop­

eration, almost all Greenpeace staff are finally using the same software to dial into our Intranet, Greenlink-3. We

continue to work on simplifying how you use the system; but can only improve this through regular feedback in

as many countries and dialing situations as possible While all your technical questions should be directed to

Hotiine@lists.gl3, any comments or suggestions on this manual should be sent to feedback@lists.gl3 .

As you probably already know. Equant has replaced CompuServe with regards to how Greenpeace communi­

cates on a global scale Equant was chosen because it is cheaper, quicker and more reliable than CompuServe.

In order to dial in to our Intranet, Greenlink-3, you need Equant.

With Equant you can retrieve your e-mail from almost any major city in the world with a local phone call.

Remember, you don't have dial back to your home office in Sydney, Australia when you are in Mumbai, India.

You dial a local Equant access number and get connected to your e-mail anywhere in the world.

Think globally, dial locally.

Last but not least, you should know that the electronic version of this manual at:

www.nli.gl3/go-greenlink

will always be more up to date than the printed version currently in your hands. Please return to this page for

future developments, answers to more frequently asked questions and further reference material. The manual

will evolve as the software evolves A list of changes in the manual since it has gone to print can be specifically

found at.

www.nli.gl3/go-greenlink/sinceprint.hfml

mailto:Hotiine@lists.gl3
mailto:feedback@lists.gl3
http://www.nli.gl3/go-greenlink
http://www.nli.gl3/go-greenlink/sinceprint.hfml


1.2 - H0¥ TO GET AN ACCOUNT ANO PASSWORD
You will need 4 things to send and receive e-mail while on the road with a laptop or during a visit to another

office:

• A Global Greenlink 3 login account/password

• An NUI and NUI Password

• A computer with a modem and the latest Greenlink-3 kit installed

• This manual

To get a global account and password and/or an NUI and NUI password, have your line manager, NRO and/or

GPI budget holders, Executive Director or GL-3 liaison staff fill out the form below:

www.nli.gl3/forms/adduserreq.html (Amsterdam)

www.us.gl3/forms/adduserreq.html (Washington D.C.)

By having a Global Login Account (also known as a Black Box/Direct Account) it means that all mailboxes are

available for email storage and dial-in on both main servers in Amsterdam and Boston (dial-in access via

Equant) as well as at all Black Boxes in larger GP offices and Direct in Amsterdam. (Note: If your e-mail address

has bb, diala, dialb after the @ sign, you already have a global login account)

No. NUI does not stand for Napping Under the Influence. It means Network User Identification Ilf you have been

in Greenpeace for a while and remember when UIC's were used with CompuServe, these are similar.) You will

need an NUI and NUI Password if you are traveling outside your country and in order for your computer to be

able to "talk" to Greenlink 3 via Equant. The NUI tends to be 8 random numbers while the accompanying NUI

Password is a difficult to guess combination of 6 or more numbers and letters.

The NUI and NUI Password are issued by Equant via Hotline and can not be changed once they have been

issued to you. So don't lose them.

http://www.nli.gl3/forms/adduserreq.html
http://www.us.gl3/forms/adduserreq.html


1.3 - PASSWORDS EXPLAINED

and a bit about

User Names

1.3.1 - GreenConnect Identity Password

For the rest of this manual, we will refer to all of these same passwords as the Global Login password. Below you

will find instructions on where the following types of passwords must be placed in relevant software programs:

Passwords can be a real pain in the ass if you don’t tattoo them on your back and carry around a mirror.

Especially when you have 4 or 5 for Greenpeace and possibly a couple others for external e-mail accounts.

The first type of password with GreenConnect is the Identity Password. This is about the only password that

Hotline does not issue. Generally you invent it yourself. If you did not invent it, then more than likely the person

that installed GreenConnect on your computer did. In any case, this password identifies you to GreenConnect

and is requested every time you open it.

Before we start with graphic explanations, you should know that the majority of confusion surrounding pass­

words originates from the simple fact that the same type of password has been given too many names in soft­

ware and online forms over the years. All of the passwords below are the same:

GreenConnect Identity Password

POP3 Password

Global Login Password

LAN {Local Area Network) Password

NUI Password

PGP Passphrase

your Global Login password

your BlackBox password

your Direct/Black Box password

- ESSEHML HEA0IK6 7



1.3.2 - POP3 Password

Please read on.

Entei youi POP3 password

8 ESSEhllAL READING

In a few cases, such as at Greenpeace International and Greenpeace Netherlands, it is a bit dif­

ferent. Generally staff from both of these offices use their LAN (Local Area Network Password -

see left) also for their POP3 Password. [ LAN Password = POP3 Password ]. The main difference

here is that for GPI/GPN staff, the Global Login Password is different

If you are confused about this and what the situation might be in your office, then check with

your local IT Contact Person

NOTE:

You should take a look at point 7.1.1 . The Local user name field (left) sometimes

causes problems with Pegasus.

Still not clear ? For GPI/GPN staff, the same password used in the 'Novell' graphic to the upper

left (LAN password! is the same as the password used in the POP3 field (lower left). For most

other offices, people would use their Global Login Password in the field to the immediate left

(POP3).

In most offices, the POP3 Password and the Global Login Password are the same

[ POP3 = Global Login Password ]

I

As you can see in the Local user name field, you put your first initial + and the first 7 letters of your last name.

Remember this password If you ever want to change this password, all you need to do is press the
| button and then the | button After that you will be asked to type in a

new password and confirm it.

Password



1.3.3 - Global Login Password

Scttrxj;

ESSENTIAL fiEA0IN6 9

If you are using lor planning on using) WS-FTP, then the password used is

your Global Login password. Assuming of course you are FTPing the

Amsterdam server, Washington D.C. server or to any of the Black Boxes.

If you need help changing your Global Login Password (which you should

do on a regular basis), please see point 421 of this manual.

Your Global Login password can go in a couple of places With GreenConnect already

opened and by pressing the | button and then the first (top) Edit button you will

find a large screen with many fields (see bottom graphic page 13). Your Global Login

Password goes in the last field (see right I If you leave this blank (which you can do if you

like to live electronically secure), then you will be prompted for it later when you are connecting to Equant and

hence Greenlink 3

In case you haven't already noticed the potential for confusion of these last 2 passwords when connecting, I will

explain Leaving both of the last 2 fields empty (the POP3 password in Pegasus and the Global Login Password

in GreenConnect) makes it a bit more difficult for the person that possibly steals your laptop from getting into

our Greenlink 3 network. (Hence you are helping to prevent perhaps" an opponent of Greenpeace peaking into a

mountain of confidential internal information.) The only downfall of doing this for you personally is that you have

to remember which one is which. Please read How Secure is Greenlink ? for some basic guidelines on security if

you haven't already.

By choosing Internet Options under the Tools... menu and then the

Receiving (POP3) tab you will find another field meant for this POP3

password If it is filled in here, erase it. This should be empty. Next

time you open Pegasus, you will be prompted for it as in the previous

graphic.



1.3.4 - LAN (Local Area Network) Password

1.3.5 - NUI Password

Passphrase

PGP is o program used to encrypt messages. If you are not familiar with PGP, then check out the manual at:

www.nli.gl3/gl3help/pgp/

If you are not using PGP (Pretty Good Privacy), then ignore this step.

Novell Login

Novell Client

Note: In some offices, the black box doubles as a LAN (Local Area Network) server; in which case the login

name/password are the global ones.

In all of these places, the user may (or may not) be using either their Global Login password, POP

3 password or most likely a completely different (separate) password There is simply no way to

generalize what this password is. The only relation to either of the past 2 passwords will be if the

user has chosen to use either for this "LAN password field" (see left)

In GP Germany they have a Lotus Notes network. In GPI/GPN, GP US, GP UK and GP Australia,

they have what is called a Novell network. In other offices there may be another type of network.

All these types of networks are called LANs (Local Area Networks).

Equant Login:
NUI: (75710005

Password (optional): I—•«

Username

Password

With GreenConnecf already opened and by pressing the j button and then the first (topi Edit button

you will find a large screen with many fields. Your NUI and NUI Password are entered here (see left). They are

entered only once and are issued through Hotline. These are used not only for billing purposes

but also to allow your computer to "talk" to Greenlmk-3 via Equant You will never have to deal

with either the NUI or NUI Password if they are entered correctly. (Unless of course you are

going to be sharing a laptop while traveling and will be needing to create a new GreenConnecf

user. See 712.)

1.3.6 - PGP

10 ESSENTIAL READING
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One small problem occasionally arises You are only allowed an 8

character limit for the Local user name field when identifying yourself

lopeningl GreenConnect. Sometimes it "cuts off" the rest of the char­

acters in your Receiving (POP3) settings in Pegasus.

As you can see in the past examples, your Local user name, Username, user name or login name are all really

the same thing. The key thing worth noting is that in GreenConnect and for your global login account only your

first initial + the first 7 letters of your last name is used (Just in case you were bad at maths in school that's a

total of 8 characters) For example, Brian Fitzgerald would use bfitzger in the relevant fields for GreenConnect. He

would use his full login name (bfitzgerald) for Pegasus Mail and for the username field in the LAN (Local Area

Network) username field. Please read on.

In this program, PGP, something called a passphrase is used. To the

right is the screen you would enter this passphrase in. NOTE: This

passphrase is a password that has absolutely no relation whatsoev­

er to any other password you use in Greenpeace.

If you find, later, once you have gotten connected with

Equant/GreenConnect that you keep getting an annoying Invalid

Username or Password error when going to check your mail with Pegasus, there's a good chance part of your

last name has been "cut off'. Check (as shown to the right) that your full, correct, “uncut" User name is filled in

there

1.3.7 - User Names

ESSENTIAL REA0IH6 11



1.4 - GETTING ANO SETTING UP GREENCONNECT

1.4.1 - Where to get the latest Greenlink-3 kit

To get the latest version of the Greenlink 3 kit check to see if your in house techie has it on cd-rom and/or flop­

pies. The current kit takes up 9 floppies. Generally it is not recommended to download it with a dialup connec­

tion If you have got a fast connection, go to:

ftp://ftp.nli.gl3/gp-sources/gl3kit/win95.GreenConnect/release/ (Amsterdam)

ftp://ftp.us.gl3/gp-sources/gl3kit/win95.GreenConnect/release/ (Washington D C.)

If you need this sent via the international courier DHL, just let us know at Hotline (Hotline@lists.gl3)

1.4.2 - Setting up Greenconnect

There are at least 3 scenarios where you will need to set up GreenConnect to work for you:

1 - If you are setting up GreenConnect for the first time, then you should use the already printed and distributed

manual at:

www.nli.gl3/connect-me/

This manual should still be available from your local IT Contact Person. If not, contact Hotline for one Then see

the graphic explanation on the following pages.

2 - If you have lost "administrative privileges" or need help with this, then please see 3.2 of this manual. Then

see the graphic explanation below

3 - If you are borrowing a colleagues computer and/or want to set up GreenConnect to use with your own

NUI/NUI Password, etc. then follow the graphic directions below. In the example, let's suppose thaf John Carella

is going to borrow the laptop of Jose Garza.

12 EESEAT1 AL READING
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Login
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Local user name:

Local casswoofc

Please indentify yourself to GreenConnect

For basic security reasons, you will be asked to identify yourself to GreenConnect. In

the Local user name and Local password boxes you will create a name and pass­

word that locks the software against others from using your account You must use

the initial from your first name and the first 7 letters of your last name. Your pass­

word must be a minimum of 4 characters. Just invent one that you will remember I Then press OK.

|r -.fr'l.j

| OK I Cancel ;



z| Amsterdam

For the time being, pick the Equant (28800 Baud) option.

z
You finish the configuration process by pressing OK.

(28800 Baud

Advanced

Settings... |■yi Add..

My location . |

Click Settings

GreenConnect

p Edit dialup location - (Amsterdam]

• GreenConnector (User = jcarella]
If you have more than one modem installed (which isn't normal

but possible), then you will have to check if GreenConnect selected

the correct modem.

Here you should fill in the Name, Country, City and Network to dial

Under Network, you will have various options to choose from such

as; CompuServe, Direct, Equant, Black Box, ISDN,etc.

To check if you have the correct modem, double click the

GreenConnect icon and enter your Login and Password. That will

bring you to the main screen of GreenConnect (left)

At this step, you should simply answer Yes I know you question

authority, but just do it.

Before you can use this account you have to add at least one d s'up location.

Wou'd you tke to add a diahjp location now?

Network to dial
Network | Equant(28800 Baud]

£xpert script option; | Manage Personal entries..

Geographical location to dial

Coumry (NETHERLANDS

Cily

| OK | Cancel |

E
Name for dialup location

Name I'Jil-V-'M-'h

Max. speed of selected network:

Phone number of selected network j* 31 (20)6826015

E
Help

r Dialup information

Log n account
j John CareDa

Dialup location
| Amsterdam

Connect to the selected location

14 ESSENTIAL READING



Click Edit Yes. You guessed it. The second (circled) one

In the following screen you will need to press Expert Script

Options...

GreenConnect takes the first modem available. If you use more

than one modem there is the possibility that the wrong one was

chosen. Please check Modem settings. If you want to use a differ­

ent modem, select it from the drop down menu.

Click OK and leave these configuration settings.

Change GreenConnect local uxet pasr/vord.

Advanced conf.^juta'.-on settings

JJier management *

Q*__ |

ESSthllF.L R £ a 01 ft u



2.1 - GREENCONNECT

2.1.1 - Identifying yourself to GreenConnect

2.1.2 - Telling GreenConnect where I am dialing to

® HOW TO GET E-MAIL VHILE TRAVELING

In field 1, you should simply give the name of the dialup location. Call it some­

thing specific. Not just "hotel" or "connection". Fields 2 and 3 are more than

obvious If there is not a dialup in the city you are located, pick the next closest.

Generally in field 4 (Network), your first choices when available, should be GL-3

Black Box or Direct. They are cheaper By choosing the Equant-NUI 128800bps]

we hove Io pay Equant about USS6/hour. In many places though you will find

only this Equant-NUI [28000bps] option

Whenever you are going to go online to check your e-mail, always make sure to first open GreenConnect and

then Pegasus Mail.

In order to access GreenConnect you first need to identify yourself You do this by

filling in your Local user name (first initial + first 7 letters of your last name) and your

Local password (the only password you invent yourself.) If this is the first time you

ore identifying yourself to the software, you will also be asked to confirm it. You

only need to do this once.

The Advanced buttons on Expert script options... and Manage Personal entries...

will be explained later in 3.3

By pressing the second -dcl I button you will be telling GreenConnect where you are dialing to. More

specifically you are telling the software which is the closest dial in point of Equant that will connect you to our

Intranet Greenlink-3. Let's pretend you are based at GPI and that you are cur­

rently in Mumbai, India trying to retrieve your e-mail

16 HOW TO GET E-MHL WHILE 1RAVELING



2.1.3 - Telling GreenConnect where I am dialing from

For the field that says I am in simply pick the country you are in.

Connect to the selected location

Since this is your first time in India, press the New... button. Type in Mumbai,

India Then press OK.

If you were dialing in to Amsterdam, for example, you currently get these 6 options (right).

Press OK and read on If you have done this correctly, you should see Mumbai, INDIA in the

DIALUP LOCATION field on the main screen of GreenConnect.

If you don't know the area code of the city you are in just ask somebody The

area code you are being asked for here is the city, county or province code of

where you are at. Unfortunately, this is not part of the software and needs to

be entered manually.

At this point, all you need to do is press this big button to the right to get con­

nected to Greenlmk-3 via Equant. If you are running into problems, check the

Trouble shooting pages.

Since I am in a hotel, I entered a 0 to get an outside line. If I needed to dial

long distance then I would have put another 0 in the next box. In most cases

you can just leave the Calling Card and Call Waiting boxes empty

Direct [14400 Baud]
Direct [33600 Baud]

By pressing the My location . | button you will be telling GreenConnect where you are dialing from. So go

ahead and press it.

Equant-MU I [28800 bi
Equant-PPPDial [64000 bps 3.3+ kit only]
GL-3 Black Box [28800 B aud]
ISDN direct [ISDN VI20 64/128k]

Tone dialing is used just about everywhere; unless you are in the "developing"

world. Finally double check the Number to be dialed is correct. Then press OK.

Hot 10 GEl e-mail vhile traveling 17



2.1.4 - Getting the latest Address Books, dial up location files and login script files

www.nli.gl3/connect-me/update-wizard.html

2.2 - PEGASUS MAIL:

2.2.1 - POP 3 Password / User Name

2.2.2 - Checking Internet Options in Pegasus

It will "disappear" after about 30 seconds if you don't. By doing so

you will be getting automatically installed the latest version of the

e-mail address books, dial up location files and login script files.

All of which are very important for a healthy, well balanced and

current GreenConnect. For more information on this, see:

Another very important task for seasoned road warriors (laptop travelers rarely based in one office) is to hit that

Update network data and address books... button (shown below) at least once a month. You should do that once

this screen pops up:

It is assumed that you have already read the 1.3 Passwords Explained section. Generally 95% of the problems

that occur when trying to get ones e-mail are based on incorrect passwords and/or user names. The Trouble

shooting pages should have the answers to the most common problems

If your problem is not listed on the Troubleshooting pages, please let us know by sending a message to

Hotiine@lists.gl3 and/or feedback@lists.gl3. Keep in mind that by reporting your specific problem(s), you might

end up helping others in the same situation!

By choosing Internet Options under the Tools menu in Pegasus, you will gel the following 3 screens shown on

the next page. Please review these screens carefully. If you not sure what should go in these 3 fields, take a look

ot the appropriate columns on Greenlink-3 Hostnames page at the end of this manual.

18 KOt TO SET E-MAIL VHILE IRM'ELIhb
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If you are traveling temporarily with a laptop and will want to be able to keep a copy

of the e-mails on your desktop computer (for when you get backl, then you should

uncheck the Delete mail option. (Basically if you check this, it is deleted from the

server and only will be on the laptop. If you uncheck this box, a copy will remain on

the server !

Please take a good look at this graphic to the right. POP3 settings allow you to receive

mail so this is important. The POP3 host field should contain the correct POP 3 host

listed on the Greenlink-3 Hostnames table The User name field should have your first

initial + your full last name. Sometimes your last name (in this field) gets "cut off" after

the 8th letter If so, fill in the rest of your last name. The Password field should be

empty here but you will be prompted for it when opening Pegasus. If you are con­

fused about passwords, see the Passwords Explained chapter. Normally, you should

check the Delete mail from host... box (as shown to the right). This will prevent your

mailbox from taking up too much space on the server

You should probably check the Download only unread mail box to avoid repeated downloads

of the same messages every time you go to check your mail Warning: Never keep the Delete

mail from host option unchecked for too long. This is a regular problem Hotline needs to

report to users on a frequent basis. In other words, don’t leave an unnecessary load of

e-mail on the server. Either delete it or store if "locally" on your computer.

Here you should have your internal e-mail address Do not put your external

@xxx.greenpeace.org addresses here! If you regularly get a "network timeout error"

in Pegasus when connecting you may want to return here and increase that number

60 to something higher. Do keep in mind though that a longer connection time costs

more money. Big surprise, no !?

P Ut?<rn ecxM I 3MTPen-Sx>e
I- £end at cnco Wr>Jp3crqn.?.>?jc
r U :e n preference 'o LAN a^iei la rrai
F Ute lot eddetl

General | Recervng (POP3| |SM 1 pj |

Gene*al :tfrQ-. (a :enir«j rrvad v-j SMTP

SMTP fjotf I’-rrip

Advanced SMTP sertanj:

Gen-rai ^eccr^ngFCPTy Scndrgr'MTF} | C'^lr<j |

I -■ I

This field should contain only smtp. Other than that, you should probably duplicate the check

boxes as shown to the right. Just don’t argue.

(.Ger.ec^I^Recervmg (POP3) | $*r<jng(SMT°j | Dwlr/j |

General :ertng:

My Internet j-mji addre:; n
|.'chn Caret&@amt ri gf3

T ineoul fa ce»wak ccrrrecborr. | GO ceccvxh
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2.2.3 - Pegasus Basics Explained

Generally the only buttons that you will really need to know ore these.

iS 0D XL W -Iv Pi l<Default> f >6 a

The first sends queued mail, the second checks your mail and the 3rd does both If you want to read some very

basic help files on Pegasus, see:

www.nli.gl3/gl3help/pegasus2.html

and

www.nli.gl3/gl3help/pegasus.html

Finally, 7.1 Quick Solutions to Common Pegasus Mail Problems may also save you some time and headaches.

2.3 - CONNECTING ANO DISCONNECTING

Just in case you didn't already read this elsewhere in the manual. Connecting

actually doesn't require you to be an overpaid, overworked IT consultant with

4 Phd's All you need to do is press that big obvious button shown to the left.

That will start your connection and transport you into Greenlink heaven. Really.

Connect to the selected location

Disconnecting actually requires a bit of effort though. You will need to get up enough energy to double click

either of the 2 little icons probably located in the bottom right hand corner of your monitor After resting from

that last big effort you should try to manage to hit either of the Disconnect buttons that pop up. Remember to do

this. It might even help us save some money that could otherwise go towards our campaigns.

Finally, in case it is not already as clear as an Amsterdam canal:

1 - disconnect after downloading your e-mail and

2 - read and write your e-mails while disconnected

20 HOk1 TO BET E-MAIL tHILE TRAVELING
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3.1.1 - Getting e-mail and getting online without the kit

In case you have not already seen:

3.2 - ADMINISTRATOR PRIVILEGE

C:\ Program Files \ Greenlink3 \ GreenConnect \ Data

ARE YOU EXPERIENCED? (?)

NOTE: This is recommended for "techies' only. You should know what you are doing. You should also know that

you will (1) have to fill out that form on page 13 again and (2) consequently will need to know your NUI, NUI

Password and Global Login Password and finally (3) will lose all your current New Dialup Locations.

If you were not given "Administrator privileges" or were not the person that installed GreenConnect on your com­

puter, but really need get to these settings, you can do so by deleting all the files located at:

there are 3 entire chapters dedicated to 3 different versions of this task. In an effort to save paper, you can print

a copy of the instructions (if you really need them) at:

Editing DUN Script for Equant

www.nli.gl3/connect-me/dunscript.html

The Greenlink Files

How GreenConnect, Equant and LT. improved global Greenpeace connectivity

www.nli.gl3/connect-me

Getting on Equant with ISDN and high speed modems

www.nli.gl3/connect-me/PPPDial.html

and

Getting on Greenlink via a Black Box, with a Direct connection or ISDN Direct connection

www.nli.gl3/connect-me/directdun.html

3.1 - ADVANCED TECHNIQUES
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3.2.1 - Advanced Configurations Options

a) I need to change how Pegasus talks with GreenConnect

Help text

(b) I need to reconfigure only the dialer and nothing more

Advanced settings
Usually after being connected for 20 minutes you will get a screen

that asks you whether you want to continue or disconnect. If you tend

to be on longer than 20 minutes, then you can change the Connection

options by putting in a higher number here.

But do keep in mind that it is costing you (i.e.. Greenpeace I) more

money. And don't forget to disconnect.
Pegasus mail options

C T3ue;f on ent GreenConnect

(• Mufti met on e>X GreenConnect

Connection options

Provide the u;er a "popup warring” after [20 rmutei of connection tme

You will just need Io locate the screen shown here. Pick the 3rd Dialer

only option under that Configuration options area. By doing so, this

option will set up GreenConnect to dial only and won't adjust settings on other programs like it normally would

do. Make sure to press OK, close GreenConnect, and then reopen it in order for this to start working. NOTE:

Sometimes this may also require you to restart your computer.

y/rfh this :ettrrg GreenConnect wd
recortigute al 3rd party appScation;
such a: Netscape,  Wintalk.
Cyterkji. Pegj-.u: Mai etc al
dal-time
That mean; Inal the settings d
•hose 3rd party appicai.on; w.1 luJ
depend on GteerConneci
Th; K He dela*£ option

You can do this by pressing the oWm** ietimg; button after pressing the Se"'ng! I

button. This part of the program is "off limits" to many users because you should really know whal you are doing

when changing anything here. The Configuration options will determine how GreenConnect and Pegasus "talk"

(work) with one another The Pegosus mail options do this also in addition to determining how you identify your­

self with Pegasus. For further explanations on these options, please read the Help Text box. (These explanations

will show up there when you select either the Configuration or Pegasus options and will not take effect unless

you press OK.

Configuration options

P Fu3 GreenConnect User dependence

C Pega:u: Maimer change only

C Dialer only
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3.2.2 - User Management explained

(a) I need to add another users Dialup Locations to my setup on the same computer.

Utct Information

Import ’<5sx.p ptoffe:'

QK I

Edi» GiecnConnect uiei

Let's say for example that John Carella is going to lend his laptop to

Jose Garza. Let's say John has traveled to 10 different GP offices and

Jose is now going to these same offices. Let's say Jose doesn't want to

set up all 10 of these separate dial up points.

Another thing is if you want to add all the Dialup Locations, etc. of the

owner of the laptop you are using. Please read on.

As you can see to the right, jcarella is currently logged on as the user

at GreenConnect By pressing the Add... button you can add other

users.

By pressing Edit... you will get the screen Io the right. There you can check the

Administrator privileges box if it isn’t checked already. This will allow persons other

than yourself to use "your" GreenConnect. In any case, ask the "owner" first if you

can have these highly noble privileges.

Jose would then press Add.., fill in his login name and then full name. He would

then be asked to fill in (and confirm) a new GreenConnect Identity password and

then finally confirm a new user request. At that point, he would simply press Yes

Jose will then show up as a user (see above) He would then highlight his name

and then press Edit...

Now all Jose has to do is press the Import 'dialup profiles'... button. This will import

all of Johns' settings for his use

GteenCcnnect U :e< ID [“ ~

Peticnd name Ijcr.e G

In order to simply add another GreenConnect user to your laptop, all you really need to do is press that first

Add. | button and fill in all the necessary details INUI, NUI Password, Global Login Password, etc.) as

explained in 1.4.2 Setting up GreenConnect.

r &dmn;tralo( ptivelesec
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3 - Assure that the Keep existing contents box is checked and finally

4 - Press the Start Import button

Irnnoil •Qtakjp Ptoblei' bom Source uier u> Deilinmion utgi

Destination user

P Keep exiting content;

GieenConnect Impoil Utility

Once you press the Start Import button, you will need to enter a valid account

name for the new account I filled in Jose Garza for the sake of continuity. Then

press OK

After pressing the Import 'dialup profiles'... button you will get the screen

to the left. You will want to.

After pressing OK in the Iasi step, Jose Garza will show up in the

Destination account box, the Progress bar will turn blue, and you will get

a message probably like the one to the left that states "Finished success­

fully, total of 4 items copied". Now you can press Close

(As stated in the NOTE paragraph to the left,, Jose will still have to fill out all of the

Account Information fields. Yes. The one where you enter your Name, IRC, GI3 E-

mail address, NUI, NUI Password and Global login Password as shown on page 13)

Piogretz Frizhed tucceifiJy, total ol 4 item; copied

■11111111111111111111111111

2 - Make sure the Destination account says New Account..

Jouicc user
jicateCa d |S3rza

Source jccounl Djzhna'ron accourX
|jobr> CaeKa d jjoze Gatza d

1 - Check that the Destination user is correct
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3.3 - OTHER RESTRICTED AREAS OF GREENCONNECT

Settings..

(a) I want to dial through Equant to Boston

(b) I'm using more than one modem and/or a mobile phone to connect

If you want or need to use a mobile phone to connect with Greenlink-3, you

will need special software (called a "driver"). You will probably need to contact

your local IT Contact Person in order to find land install) the correct driver for

your mobile phone. Once installed, it would be accessed via the drop down

menu (not the Configure modem settings... button). The setting shown here is

the Default setting for this modem. Your setting here may be (and probably is)

different.

In order to dial through Equant to Boston, you will need to duplicate the exact

settings as shown to the right (An example of when you may need to do this

is when the Amsterdam server is down).

Note. All of section 3.3 of this manual should generally be done with the assistance of an IT Contact Person and

when advised by Hotline. It is highly recommended that you don't touch any of these "Administrator Privileged"

areas unless you really know what you are doing and/or you are being instructed to do so by Hotline. You have

been warned I 

3.3.1 - Expert Script Options briefly explained
Just in case you haven't noticed, the only way to get to "into" the

] button and then the second £*■ button.

£^1 script opto™ section is by pressing the

To get to the M«»pe&nonder*es section, you just need to follow this same path or just the second A1** |

button.

You will get a screen similar to the one to the right once you press the

Expert script options button.
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3.3,2 - Manage Personal Entries explained

a) I'm in the middle of nowhere, regularly, and need to add a special number.

!>>* |
Modus Adding a new item

Editor of the Personal Network Entries

■3
■3

If a user wants or needs to use an ISDN modem, a special hardware extension to the modem needs to be

installed. This tends to include the appropriate software in order to make this function.

But remember, selecting any of these will affect how the GreenConnect soft­

ware "talks" with Equant.

At GPI, NCT generally installs the Xircom Real Port Integrated PC Card This allows a user's laptop to "talk" only to

an analog modem. When NCT gets a request from a user to have this card installed, they need to install the cor­

rect software for a specific phone (be if Nokia, Ericcson, etc.I

After pressing the Manage Personal entries... button you will not get the

screen to the left. You will get another screen giving you 4 options: Add, Edit,

Delete and Close. Since this is probably the first time you have ever been

there, pick the Add button. Then, and only then, will you get the screen to the

left. After choosing the country, city and network the other fields will be auto­

matically filled in You do in fact have the option Io Choose... what is called

another Login Script code, but more than likely will not want to do that without

consulting your local IT Contact Person or Hotline first But since you like to live

on the wild side. LoginE.scp = Equant, LoginB.scp = Black Box,

LoginD.scp = Direct and LogmP.scp = PPPDial

The usefulness of this part of the program is to allow you to add dial

up numbers that may not already exist in current address books

Assuming you hit that Update network data and address books... but­

ton (see below) on a regular basis, this would probably not be neces­

sary

Choose the country

|f HA.1 LAND

Network

Max network tpeed

Phone number

Logn Script code

Make your own entry

|Bangkok

|Equant-NUI

128500 bo:

f]? {|2370373

To access this part of the program, you need to press the I button and then the existing dialup locations

there. Once there, you press the Monos-button.
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The only instances you would ever need to actually do this is:

3.4 - OTHER RAINBOV ROAD WARRIOR POWER TOOLS

www.nli.gl3/gl3help/ftp2.html

www.nli.gl3/gl3help/ftp.html

Once you press OK you will be osked if you would like to add this new entry to the Personal Entries list. Just say

Yes and don't argue. You should then see this entry next time you press the Manage Personal entries... button.

• or when numbers are not provided by Equant, but could still be used. Such as so-called "hidden" nonpublic

Equant/SITA numbers. But since Equant, unlike CompuServe, is not an "end user provider" these numbers can

only be specially requested by Hotline.

when new numbers aren't yet distributed via Nefwork.dat (ie you haven't pressed the Update Address

Books... button in a while).

or for numbers that require special dial prefixes or shortened numbers. Fo example, extension 678 rather

than 5236678 in the GPI office.

3.4.1 - Using to transfer numerous big files
Wsjtp exe

FTP is another program found in the Greenlink-3 that is very much underused within Greenpeace, but is a very

powerful tool for moving numerous (usually large) files from one's computer to a centralized server. This is useful

for particularly action and/or Comms staff that may need to send numerous photos to John Novis (GPI Picture

Editor) for international distribution. This is a much more efficient means than sending as attachments not only

because of increased speed during the transfer process, but also because it is centralized in one place (a serv­

er) where everyone can "grab" these files from. For more information on how to use WS-FTP, see pages 40-47

of your How to use Greenlink-3 manual or view them on the internal web at:

or when area codes have recently changed.
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You con use a handy little program in the latest Greenlink-3 kit that will really make you feel like an authentic

techie. It's called Cyberkit and you will use if to do something called Ping. Traceroute and NS Lookup. They are

all used to find out if your computer can "talk" to a server and where the problem is based. Just play around

with these mini programs to gel a feel for what they can do. The information you might get back may not help

you, but may very much help your local IT Contact Person and/or Hotline

Ping

Fill in the appropriate Host or address in field 1 shown to the left. Then press GO

If something similar shows up in area 2, then you can rest assured that you can, in fact, connect to

that server. If nothing comes up in area 2 or you get a series of error messages, that information

will help your local IT Contact Person lor Hotline) to resolve the root of the problem

TraceRoute

Fill in the appropriate Host or address in field 1 shown to the left. Then press GO.

If you see something like what is in area 2, then you will know the path that your mail land other

data) is taking through the Greenlink-3 network If the last line in area 2 (#5) did not end in au.gl3,

then you can know where in this path the communication is broken. This information can be useful

for the IT Contact Person and/or Hotline.

NS LookUP

Fill in the appropriate Host or address in field 1 shown to the left. Then press GO

This tool let's you test if you have a real server name that is valid; provided you have no connection

problems. For example You can know if bb.new-zealand.gl3 is an invalid server name, but

bb.nz.gl3 is a valid one. This information can also be useful for the IT Contact Person and/or

Hotline.

3.4.2 - Using ^3 to analyze connection problems
[Cj>befp exe

Let's pretend, for this example that you are normally based at GPI but you are visiting GP Australia. Let's say the

local techie there is out of town and you really need your e-mail. You will need to use the Greenlink-3

Hostnames page as a reference for what you would need to put in the Host or Address fields.

NOTE. In most cases you will need to check either the POP3 server (mail receiving) and/or SMTP

server (mail sending) Having said that, you can also check with these programs, if you have the

inclination, the availability of Web servers, FTP servers, and Telnet machines.
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TROUBLESHOOTING

4.0 - SOME GREENCONNECT ERROR MESSAGES: REASONS ANO SOLUTIONS

4.0.1 - Invalid password error

4.0.2 - The line is busy

| Invalid pasiwordl

STOP

[Dialup location: Amsterdam direct

This has the same effect as picking up the phone and dialing

nothing After a while the dial tone stops waiting and changes

into a tone which is like the busy tone.

To the right you will find the graphic example of the more common error messages. To the left you will find the

reasons, solutions and pointers to other help pages.

3 - When the server name from which you are downloading is incorrect Double

check that you have filled in the correct POP3 and SMTP hosts also found

under the Tools > Internet Options in Pegasus. A chart of the correct Greenlink3

Hostnames is found at the end of the manual.

Connection faded.
The Lne is busy.

This is happening because you are using pulse dialing instead

of tone dialing (or visa versal.

If your problem is not listed on these Troubleshooting pages, please let us know by sending a message to

Hotline@lists.gl3 and/or feedback@lists.gl3. Keep in mind that by reporting your specific problem(s|, you might

end up helping others in the same situation!

1 - You are inserting the wrong password in Pegasus Mail. (See 1.3 for more

help) or

2 -Your username is wrong. Make sure you have filled in the correct user name

al: Tools > Internet Options > Receiving (POP3) (See 1.3.7 for help.] or

The POP3 server you have rpecfied in your -«•
Network Ccnhguatjon setting: ha: returned an
enor code indicating that the password you have
suppl-ed for your account n nccnecl On some
systems, this enor may actually alto mean that
you have given an invalid user name, '.nee
revealing that a username is vaid can be seen as
a potential security breach.

Please coned the password or username your 
Network Configuration screen and try agan

Note that although they may be legal. passwords
whch context spaces may cause problem: If
your password on the POP3 host contain:

| 6f!1> ]

See 4.1.4 for more help.
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4.0.3 - There is no answer

Yes. You guessed it. There is no answer. The modem you are calling to is not picking up. Possible solutions are: 

3 - Check "My location' for dial prefixes, area code, etc.

4 -Try another dialup location.

4.0.4 Another potential solution to the above problems

2 - For Xircom modems, follow the path:

Start > Programs > Xircom utilities > Country select

Solution:

For all of these cases where the modem apparently works, but no

connection is made there is a solution At least for "modern" modems

such as Xircom (what is used at GPI/GPNI. Here it is: 

Problems:

1 - The modem starts to dial but you can still hear the dial tone through the modem or

2 - The modem simply doesn't start to dial and you don't hear a dial tone or

3 -You have switched from tone to pulse dialing, but the modem is still using tone dialing

1 - Check the number you're calling to

(See 2.1.2 for more help.) 

2 - Update you're Address book. The number could be wrong or old or both.

(See 2.1.4 for more help.) 

1 - Find out if there is a "Country selection utility" that was

installed with the modem.
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3 - In this utility, select the country your in and press Save. This will set up the right modem settings to make the

modem work in that country. Try again These settings will overrule any settings you put in manually!

4.0.5 - Error messages when an old modem has been replaced

The solution is to go to:

Settings > Edit Dialup locations > Expert script options 

and select the correct modem you want to use.
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NOTE: For other modems you will have to find this utility yourself {if it exists). Ask you local IT Contact Person and

or Hotline if you don't know where to find this. You can find some useful settings at: Start > Control Panel >

Modems

1 - Close Greenconnect.

2 - Double click on the My computer icon on your desktop

3 - Double click on Dial-up Networking, right click on Greenconnect

and choose Properties ...

If you get this error message {right) when clicking on Expert script options while trying to solve

the previous problem {or if you don't have "administrative rights" in GreenConnecf) the only

solution is:

... you will probably get a message like this one to the right Just press OK

and continue.

These first 2 error messages you might get when trying to dial (right). The modem that

Greenconnect is currently configured for doesn't exist anymore.

U/UJJ



CcyTty cole-

P cod? and

In the Connect using box choose the correct modem.

By pressing OK, everything should be working ogam.

4.1 - QUICK SOLUTIONS TO COMMON GREENCONNECT PROBLEMS

4.1.1 - I can't open GreenConnect and forgot this password

PD|
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The modem configuration menu will open, looking like the graphic to the left Make sure

you are at the General tab.

If you have done this correctly, you will see a picture of a telephone next to

that box Isee right) That means there is now an existing modem that should

be working.

But instead of using your first name + 7 first letters of your last name, you will have to

use something else. For example, normally I would open GreenConnect by typing in

jcarella and then my local password. Since the program still remembers this, I will

have to use something else like johncar in the Local user name field. You might want

to read the 1.3 Passwords Explained chapter again. Whatever you do, make sure to

pick a password you won't forget I

That's too bad. This is the one password that Hotline doesn’t issue. In order to make GreenConnect work again

you will have to repeat all the steps explained in the 1.4.2 Setting up GreenConnect chapter Hopefully you know

your NUI, NUI Password and Global Login Password; otherwise you are going nowhere Quickly.



4.1.3 - I get the message that the modem can't detect a Dial Tone
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More than likely this has to do with the modem settings of your laptop. Or more specifically, how your mobile

phone is "talking" with GreenConnect. First lets check to see if your local IT Contact Person has already installed
the correct drivers/software in order to make this all work. Press the Start button in Windows (bottom left cornerl,
then Settings, then Control Panel, and then double click the Modem icon. At GPI, NCT generally installs the

Xircom Real Port Integrated PC Card. This allows one's laptop to "talk" to a mobile phone so it can "talk" to
Greenlink-3. If you don't have an entry (something like what is shown below), then that means you are missing

the correct software (driver). Talk to your local techie for help on this.

pick the drop down menu (see right) and not the Configure modem settings button. Select another modem

there. The example to the right shows what you would pick with an Ericsson model.

The first thing to do do is to see if there actually is a dial tone from where you are dialing. If you don't hear a dial

tone, then check your line. Something is wrong with regards the line or cabling. Make sure that the plug from

your laptop to the phone line jack is properly connected.

If you hear a dial tone, something is wrong with your modem or the dial tone is sending a protocol (something

like a signal) that your modem doesn't understand. The solution is to follow this path:

Then select the correct modem. Then press the Properties button and then the Connection tab at the top. Once
there, just uncheck the box that says Wait for dial tone before dialing. That should fix this.

4.1.2 - I can only use one modem, the second one doesn't work
(i.e. a mobile phone modem)

Hopefully you have "Administrator Privileges". If so, press the Settings. ’

button, then the second Edit... button from an existing Dialup Location. (If

you don't have one, press that 2nd Add. button right above the Edit., button,

create a new Dialup Location and then continue). Once there, press the

Expert script optijns.. i button. At the button where it says Modem Settings, 

Start Menu > Settings > Control Panel > Modems



4.1.4 - The Modem won't dial the phone

If so, choose that Pulse option (last option to left) and press OK.

4.1.5 - I always get disconnected after 20 minutes

Advanced configujdt.cn jettings .

This probably has to do with the fact that you are in a country where they still use

good old fashioned Pulse Dialing. In parts of the "developing" world Pulse Dialing is

still used.

GreenConnect is set up to automatically disconnect after 20 minutes. Most of the time

a little screen pops up above your other open programs and asks you whether you

want to Continue with your connection or disconnect It looks like the graphic to the

left. If this doesn't happen, then use your watch to time this from the moment you go

online. When about 18 minutes have passed, minimize (don't bother closing) all your

other open programs and press the Keep Connection option

4.1.6 - This phone wants me to dial something to get an
outside line.

If you have got Administrator Privileges to GreenConnect then press the jetting:

button and then the danced ctwpjaun . | button. There you can

increase the default number from 20 to a higher number. But do remember (1) this is

costing you (i.e. Greenpeace) money that could otherwise go towards our campaigns

and (2) to Disconnect ,

By pressing the Mytotnn | button in GreenConnect you get the screen to the

left. You see that 4th box there. It is here you fill in the correct number to get an out­

side line. Most of the times its a 0 The box next to it needs a 0 only if you have to dial

long distance.
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4.1.7 - There is calling waiting here. How do I adjust this with the software ?

Easy. You see that last graphic at 4.1.6 See that last little box that says This location has call waiting. To disable it,

dial. You will need to check that box and find out from someone at your location what the number it is to disable

call waiting. If you are in a hotel one has Io be persistent with this question Often they don't know the answer and

reception has to pretend to know while going to ask someone else more informed on such "technical issues". Just

grab a seat and take in the beautiful surroundings of the hotel lobby.

4.1.8 - There are spies out there. I want to change my GreenConnect password.

OK. But you will need to know your current local password. Once you have GreenConnect open press that
Seninas... J button again. Then press the GieerConnfct toi use, wscti J button. There you will be

asked to type in your current password and then your new password twice.

4.1.9 - I'm outside a major city and it's a long distance call to the capital.
Which dial in location should I choose ?

This is a no brainer, but since you asked, you should always choose the location closest to you. Just go through

the regular steps of telling GreenConnect where you are dialing to ( Add. | |; making sure to pick the city

closest to you. There is no way that GreenConnect can automatically detect the closest location. If you are not

sure, you will have to ask a local, hotel reception, etc.

When you are telling GreenConnect where you are dialing from I |). just make sure to add the cor­

rect area code for the city/county/province you are in.



Here is the procedure to fix it
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(a)

(b)

(c)

(d)

(e)
(fl

(g)

Here's is the problem to fix it. Since the GP-US office moved to another location, the NAS Ian infernal Equant

number) changed. This problem is present only in dialing locations in Oceania and the Americas.

Start GreenConnect Provide your username and password

Press the Settings button

For each dialing location in America, Oceania or Australia follow steps d to g.

Click over the location and press the Edit button.
Press the Expert script options button. lYou should come to the screen found on page 25.1

Select the Alternate CompuServe host name / Alternate Equant X121 address of the NAS1' option.

Fill the field to the right of address of the NAS with: 2117153001

4.2.0 - In the dialing process, when I get to the verifying username and
password part, it opens a black window. What does that mean ?

SITA NETWORK : 2661337

nui 75711234

SITA Network: password

xxxxx

SITA Network: user network identifier error
this means that your NUI and/or NUI password is incorrect. Please make sure you are typing these correctly

Then it means that you are trying to reach the old Washington DC (Boston) node. And you are using an old

phone book (network.dat) file. Please update your network files regularly to prevent this situation. This is done by

pressing the Update Network files and address books button that appears immediately after connection.

If you receive something like this: SITA NETWORK : 2661337

nui 75711234

SITA Network: password

xxxxx

Sita network : network user identifier 75710159 active

2104791001

sita network :call cleared - temporary network problem

If you receive something like:



4.2.1 - I would like to change my Global Login Password. How do I do it ?
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(k)

(I)

In the host box, type in pop.nli.gl3 in the Host field to the right. This is what all staff should currently do to

change this password This is avaiable for the Amsterdam server, Boston server and all Black Boxes

In the Greenlink 3 kit, there is a program called TeraTerm. Find that program, open it, and follow these easy,

graphic steps.

With these steps you will be able to connect. Nevertheless it is strongly recommended to continue with these

steps also:

press the Update address books and network files button.

Once you get the message that if has been successfully updated. Disconnect.

At the greenconnect main window press the Settings button.
For each dialing location in the Americas, Oceania or Australia follow these last steps.

Click over the location and press the Edit button.

(m) Press the Expert script options button.

(n) Make sure the Boston option is selected and press OK.

(h)



SunOS UNIX (cohjr.nk.Q13l (tt«p5)

E<n Setup Centred \vndcn* He's

File Edit getup Control V^indow Help

www.nli.gl3/gl3help/teraterm.html

2 1e,a Ic,m ■ pop.nli.gI3 VT
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Type in your login name. Press Enter

Type in your current Global Login Password Press Enter

This will bring you to the main screen of this program. There are 10 different

areas of the program. Use the arrow buttons to the right of you keyboard to

navigate down to the line that says Change your login password (as shown

to the left). Then press Enter

There you will be asked to type in first your Old Password, then your New password and

then your New password again just for confirmation. Then press Enter That is all it takes.

Wasn't that exciting ? For further help on how to use other parts of this Telnet program,

see: 

4.2.2 - I'm dialing to a correct number but it seems there is no modem at the
other side.

Grwnpeace t«xt-battd rf-J access services.
Ueleone to Lynx.

• Erouse Greer^-sce Internalional’: Min Green!iri-3 UHU pages
• Grouse the text band Ct-pr-er archive nenus

• It your e-nsil it normlly stored on your office Mil tytten,
retrieve that renote Mil via F0F3 to this host first.

• Read I trite Nail t Neu; «i this host.

Hrrou key;: Up and town to now? Right to follow a lint; Lett to go baa.
H)e!p OJpticns Plrint GJo Main screen Qluit Z«search Ideletehhistory list

* File ttaMjenentt including up/dounloading)

• Tab to another logged-in user anywhere on 0.-3.
• Internet Relay Chat (IRC)

• Charge your login JEI3E'
• hail forward ard auto-answer
• Cr>ecl the anxffit of disk space you have available on this server

login: jcarella
'a:sword:

Probably you need to dial a prefix to get an outside line. If this is the case then press the !ol:at°n I button.

Look at the number next to the bottom Number to be dialed pari. This number should include all the appropriate

dial prefixes and area code needed to get a telephone connection.

Changing N1S password for jcarella on solair.nh.gl3.
lid password:
leu password:
Mype new password:

File £d< getup Control Window Help

http://www.nli.gl3/gl3help/teraterm.html


7.1 - QUICK SOLUTIONS 10 COMMON PEGASUS MAIL PROBLEMS

EZ
GenwS Rec«vr<j POP3) | SendngtSMTP) | |

POP3hcct P

Advanced POP? ce'tr'g:
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If it still doesn't work, check that all of the following settings are correct. Sometimes

this means asking the appropriate person in the location you are at:

Why is this happening you may ask ? Well here's the answer. When you start up

GreenConnect you are only allowed to use 8 letters. Sometimes this affects this

user name in Pegasus. Just type in your first initial and your full Iasi name here lor

whatever your correct login name might be). Remember to keep the password field

here empty though. You will be prompted for this POP3 password later when first

opening Pegasus.

More than likely this is because your name has been "cut off in the User name

field of Pegasus This is found under the Tools menu under Internet options and

pressing the Receiving (POP3) tab as shown below.

NOTE: If you are wondering why this section suddenly jumps from 4 2.2 to 7.11, there

is a simple explanation. It is assumed that more Quick Solutions to Common

Problems with both Pegasus and GreenConnect will come in after the hard copy ver­

sion of this manual has been printed and distributed. This “leaves room" for future questions and

solutions in the electronic version of this manual Please make sure to occasionally check

the following webpage for changes/additions/errors/etc. that have occured since the manual went to print:

1 - The area code

2 - The number to get an outside line

3 - Perhaps they have call waiting there. If they do, check that box.

f~ Dovrio-sdcr-Vyraeadma)
APOP shared -.eaet (opocnai) f

7.1.1 - I'm connected with Equant, but receive a
POP 3/Username error message in Pegasus.

| f OK Cared |

r Don? check ire rdentxy when checkr>g mjpie KXritm

(Sedngi r> tfxi page acpJy orJy to cunert>? je'ected cJerMy)

www.nli.gl3/go-greenlink/sinceprint.html

http://www.nli.gl3/go-greenlink/sinceprint.html


There are actually 4 different options here for this with varying degrees of ease: 

www.nli.gl3/connect-me/configure.html
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This is done by filling in your user name (ond an invented passwordl in the first GreenConnect screen You will

then need to fill in lhe previously stated information (NUI, NUI Password. Global Login Passwordl and follow the

instructions the software gives you. If you need further, graphic help with this, please see

3 - Changing Identities
The 3rd option let’s you change the identity of who "owns" the incommg/outgoing e-mails of the computer you

are sharing. You can find this by choosing Identities under the Tools menu (Note By following the path Help >

Help Index > Search and then typing in Identities in Pegasus Mail you will find instructions on how to set this up.I 

2 - Using Change Users...

The 2nd option is to use the File > Change Users... option found in some versions of Pegasus moil.

1 - Creating a new GreenConnect User

Assuming you have your NUI. NUI Password and Global Login Account password with you, the most efficient

way of doing this is by creating a new GreenConnect user. While this may be more difficult than the other

options, it will prevent the e-mail of both persons getting mixed up. It will also charge the usage to the correct

budget codes

4 - Using MultiPOP
The 4th (and final option) is perhaps the easiest, but not necessarily the "cleanest" of options. This option is a

quick and dirty way of getting the e-mail of 2 different accounts into the 1 computer you are sharing.

7.1.2 - I'm traveling with colleagues and they need to check mail from my
laptop also.

http://www.nli.gl3/connect-me/configure.html


Ccnnecbon fid - -

Press the Add Button.

Check now

n MultiPOP

BHG

Recommendation: Since I probably have 149 messages sitting in my New Mail Folder and I

don't want to get all of Bill's messages from Monica mixed up with mine, I should first (1) file

my new messages into another folder (2) create a folder (and filter) where his messages will

go into and (3) change Identities so Bill can reply with his e-mail address and not mine

We filled in the correct POP3 host, his full username, but we left the

Password field empty so as to be prompted for it later We also added in the

bottom box his main e-mail address where people can reply to.

Under the Tools menu, and then Extensions you will find a MultiPOP option. Choose this

MultiPOP option. This is a very useful, little feature in Pegasus for checking 2 e-mail accounts

on different servers at the same time

While in a hotel recently in Brussels, the author of this manual was asked by

none other than Bill Clinton if he could check his e-mail from my laptop. He

happened to have an account in the Washington D.C. office. He said he was

fascinated by "all dis cumpeuter stuff" but hadn't the faintest idea how to

check his e-mail. I suggested good ole MultiPOP

Fill in the correct POP3 host for your office. Remember that you can check

this on the Greenlink-3 Hostnames page. Fill in your full user name and

leave the password box empty. You will be asked for this later on Not sure

what your POP3 password is 7 Then read the Passwords Explained chapter

again.

-

After pressing OK in the last screen, all you need to do is press (after you

are already connected via your colleagues account) the Enable button and then the Check

now button. That’s all it takes

Add I

Enable | 0 cable

He'-p

Add

Enable

Connection bd

Help |

1 ™ 1| Remove |

| Oiubk- | Check now |

a MulliPOP
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7.1.3 - During mail download the connection ends. It keeps happening on the
same message. I know it has an attachment. How do I fix this ?

You can find the screen to the left by choosing Internet Options

There are a few things you can do here. Check any of these pages if you can get online with Netscape:

After you have already retrieved all your mail lexcept for that troublesome attach­

ment), set it back to 0 and fry again. Check the Download only unread mail box and

try again. This should grab that lonely attachment still sitting on the server.

Another option is to use Selective Mail Download which can be found under the File

menu This will let you pick and choose which e-mails to download lor nofl

You should probably increase the setting in the 5th field that says Do not download

mail larger than to 300 KB when traveling This will probably download everything

except big, troublesome attachments.

Search through all PegasusMail address books

http://www.nli.gl3/cgi-bin/search-staff

Greenpeace Staff Directory Online

http://db02.nli.gl3/sdo/

7.1.4 - I don't have an address book and can't remember how to e-mail someone
in Australia.

If you are not sure what what goes after the " @ " sign for a particular person in a certain office, you can also

find these under the internal or external columns of the Greenlink 3 Hostnames page at the end of this manual.
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/jrEESft Connected lo Amsterdam -Equant

. Update network data and address books.

Having said that (and assuming you have GreenConnect installed!, you should really get in the habit of clicking

on that Update network data and address books button shown below. This screen is only accessible the first 30

seconds of being connected, so do if first thing. Do it every month or so. It will automatically update all of this for

you.

If you don't have GreenConnect but have a working connec­

tion with Pegasus and Netscape, then another (far less effi­

cient but workable) option is to download the address books

(individually) at:

ftp://ftp.nli.gl3/gp-sources/pmail/address.books/

There you will be able to pick and choose which offices you need. Make sure, for example, if you were to want

the Amsterdam address book, to download both ams.pm! and ams.pmr. You can do this by pressing the

appropriate link and pressing Save as., under the File menu, not changing the default name and saving them to

your Pmail folder probably located at:

C:\ Program Files \ Greenlink-3 \ Pmail

7.1.5 - I've got an ISDN modem. The office I am in has ISDN. Help anywhere ?

Yes. You can find Help files at the following webpage:

http://www.nli.gl3/connect-me/PPPDial.html

It will benefit users with ISDN or high speed modems making connections where PPP dialing is available. You

can usually find this in the Network to Dial option found when creating a New Dialup Location in GreenConnect.
Yes. Under that second Add | button.

Dialup location: Amsterdam

TR0UBLESH03IIH6 <3
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Finally, don't forget to choose the correct modem settings as demonstrated in 4.1.2 .

Confused 7 See 1.3 Passwords Explained

jicaeU

[64000 bps 3.3» kit only]

Novell Client

NOTE: This option is not implemented in the greenlink kit version 3.2 It will be available in ver­

sion 3.3. In the mean while, you can follow this easy procedure to get on the PPP technology.

If you are GPI/GPN staff and you know you have gotten a screen stating something about a User

name/possword error, (and you have gotten this error at least 3 times) then you should call NCT

at: ++ 31 20 523 6271 and ask them to unlock this password block that has automatically been

set.

In some of the bigger cities you will find as many options as those shown to the left. In which

case you would pick either the 4th or 6th option:

The source of this problem could be 2 things. The more obvious is that you are simply not connected to

Greenlink-3 (via Equant) before going to check your e-mail. Make sure you are connected (i.e. online) before

choosing the Get mail option.

This is a common problem that gets reported to NCT (the GPI/GPN Computer Support Team) on a

regular basis with regards to GPI/GPN staff traveling with laptops. This happens because users in

these offices are more than likely (mistakenly) placing their Global Login Password (or something

else that's incorrect) where they should be placing their LAN (Local Area Network) Password. Which

for GPI/GPN staff also happens to be the same in most (but unfortunately not all) cases, as the

POP3 Password.

Uietname.

Pasiwotd

GL-3 Black Box {28800 Baud)
ISDN direct (ISDN VI20 64/128k)

Direct [14400 Baud)
Direct {33800 Baud)
Equant-NUI [28800 bps)

Direct [14400 Baud)
Direct [33600 Baud)
Equant-NUI [28800 bps)
Equant-PPPDial [64000 bps 3.3+ kit only)
GL-3 Black Box [28800 Baud)

7.1.7 - I keep get an Error connecting to host! message when going to check my
e-mail. How do I fix this ?

7.1.6 - I'm based in GPI and I've receive a user name/ password error 3 times.
How do I fix this ?

ISDN direct [ISDN VI20 64/128k|.

|» U Novell Login
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■ If you ore not dear which servers you can use, see lhe POP3 Host and SMTP Host columns

on the Greenlink-3 Hostnames page.

There is a temporary solution which involves changing lhe Sending (SMTP) and the Receiving (POP3) settings in

Pegasus Mail. These settings can be found (and changed) by choosing Internet Options under the Tools menu

What you are actually doing is using another server to change where you are sending mail from and where you

are going Io receive it from Consequently, the recipients of your e-mails will temporarily be seeing another

address Rather than getting your mail from Your.Name@dialb.gl3 they will temporarily be getting it from

Your Name@mail.au.gl3 Confused ? Please read on.

More than likely though, your host entry is incorrect Take a look at the settings explained in point 2.2.2

Checking Internet Options in Pegasus You should really double check that the General, POP3 (Receiving) and

SMTP (sending) options are all correct (i.e. related to the office you are dialing to) on the now world famous

Greenlink 3 Hostnames table found al the end of this manual

Note: Since this is just a temporary workaround, please remember to put everything back to

their original settings once you know that the server is working again. And don't forget to

remove what you put in lhe Send Replies to. field This is all very important I

Everyone who has a Global Login Account can use any server to send and receive mail from. Let’s imagine that

you have a dialb account Let's pretend you are at GP SouthEasf Asia in Bangkok. Let's say you are having trou­

ble getting/sending important e-mails. Let's say that you have gotten a "SMTP Host Error".

What you can do is change the Sending (SMTP) setting from smtp.bos.us.gl3 to smtp au.gl3 . This will send the

mail out from lhe Australian server. If you just need to gel that mail out, change only that Sending (SMTP) set­

ting Since you probably need the capability to receive mail also, you should change the Receiving (POP3) setting

from pop bos.us gl3 to pop au.gl3 Since no one knows about this "new", temporary address, you will need to do

one last thing. Write your e-mail. Press either the F9 key or the Special tab and fill in this temporary address with

Your.Name@mail.au.gl3 in the Send Replies to... field.

7.1.8 - I urgently need to send out an e-mail but keep getting an
"SMTP Host error". What can I do ?

SMTP « cerxjngll
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r 1 - Greenlink-3 Hostnames

■ www.nli.gl3/gl3info/hostnames.html#TABLE

I
 Table of Internal and external e-mail addresses, POP3 hosts, SMTP host, internal WWW servers, internal FTP

servers, and Telnet machines. (A current list of all this information is at the end of this manual.)

1
2 - Use of Firewall to go outside Greenlink 3

www.nli.gl3/gl3info/firewall.html
I Are you having problems getting connections with Netscape/lnternet Explorer on the public Internet ?
| |i e. outside Greenlink-3). If so, check out this page for the correct settings and solutions.

3 - What is IMAP ?

www.nli.gl3/gl3info/imap.html

Accessing your Pegasus Mail folders remotely

> 4 - How to install the new Greenlink-3 kit (with GreenConnect)

I
 www.nli.gl3/connect-me/

How Greenpeace, Equant and I.T. improved global Greenpeace connectivity

| 5 - What's a Black Box ?

www.nli.gl3/gl3info/blackbox.html
L Answers to questions such as What is a GL-3 Black Box ?, What can it do for us ?, Is this suitable for my office ?,

But what about the costs ?, What hardware do I need ?, Why do we need Equant ?, What is Linux? and

How does our office get one ?

1
6 - More information about Equant

www.nli.gl3/gl3info/equant.html
Mostly technical, background information on Greenpeaces' new Intranet and Internet provider.

7 - The Big Picture: the worldwide network

www.nli.gl3/pics/GL3connectivity.grf

r A graphic of what the Greenlink-3 network looks like This is also on page 48.
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12 - How to download, set up and use PGP (Pretty Good Privacy)

www.nli.gl3/gl3help/pgp/

Step by step instructions for using this "industry standard" encryption program which allows one to send/receive

both e-mails and other files in a safer (and more secure) manner.

11 - How Secure is Greenlink ?

www.nli.gl3/gl3help/d-security.html

Common sense computer security measures that everyone should know about Brought to you by Dick Dillman.

13 - PC Webopedia (external)

www.webopedia.com

The only online dictionary and search engine you need for computer and Internet technology terms.

10 - GPI/GPN Computer Support or Global Greenlink-3 support ?

Your first line of computer support when at GPI/GPN in Amsterdam should always be NCT I www.nli.gl3/nct).

They are on the 2nd floor. For global, Greenlink-3 (i.e. GreenConnect, Equant, etc.) support, see Hotline

( www.nli.gl3/it/hot.html). They are on the 4th floor Their e-mail address is: Hotfine@lists.gl3

8 - Network Greenpeace Amsterdam

www.nli.gl3/rt/network.htm

This rather technical diagram of the Amsterdam network includes the main building on Keizersgracht, the

Annex, the Leliegrachl (where the Finance and Legal Deportments are) and the Warehouse

9 - IT Contact Persons

www.nli.gl3/it/intcontact.html

This is a web page listing the IT Contact Persons in all our offices.
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J THE BIG PICTURE: THE GREENLINK-3 NETWORK

Equant V.'DC node

Pub-C Internel

Equant AMS nodeu !•-!(.-J

Last Update November 2000

Toronto
yto.us gl3

192 168 1900

Stockholm
nordic gl3

192 163 46 0

Vancouver
yvrcagl3

192 168 160 0

Seattle
sea us gl3

192 168 126 0

Manaus
amazon gl3
192 168 59 0

San Francisco
sfo us gl3

192 168 141 0

Washington
wdc us gf 3

192 168 120 0
bos us g!3

192 168 1610

Soo Paalo
br.ql3Brussels

begl3
192 168 32 0

Zurich
ch gl3

192 168 410

London
ukgl3

192 168 44 0

nz gl3
192 168 64 0

Sydne/
ou gl3

192 163 610

Homburg
de g!3

192 168 49 0

ru g!3
192 168.7 0

Amsterdam
nl gi3

192 168 310
192 168 2310

cz.g!3
192 168 42 0

if at gl3
192 168 243 0

Buenos Aires
or g!3

192 168 54 0

Denmark
dkg!3

192 168 45 0

Pans
lr gt3 at gl3

192 168 33 0 192 168 43 0

----------- private equant leased line
■■ "■ funnel through the public internet
— — tunnel through equant private network

fiql3
192 168 79 0

□nc us gl3
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GREENLIHK-3 HOST NAMES
1 EMAIL

~ ..
ADDRESS DOMAIN POP3 HOST SMTP HOST WWW FTP TELNET

INTERNAL EXTERNAL

Moin (dial-in)

BOSTON/WDC

©dialb gl3 ©dialb greenpeace org pop bos us gl3 smfp bos us gl3 www us gl3 ftp us gl3 axil bos us gl3

Moin (dial-in)

ADAM

©diala gl3 ©diala greenpeace org pop.nli gl3 smfp nli gl3 www nil gl3 ftp nli gl3 scteir.nirgl3

) GPNL ♦ InD

office

©ams nli gl3 Gams greenpeace org oms-1 nt g!3 not avaSctte not avo-’abie not eva’ette net avotette '

) BB

A'DAM

©bb nli gl3 Gbb-n'j greenpeace org bb nli gl3 not avalcble bb.nli gl3 bbn3gi3 bb nli gl3

\ BB

SAN FRANCISCO

©malslo us.gl3 Oslo greenpeace org pop.sfo us.gl3 smlp sfo.us g!3 wwwsfo us gl3 ftp sfo us gl3 bb sfo.us gl3 J

WASHINGTON

' DC office

©mad wdc us g!3 ©wdc greenpeace org pop wdc us gl3 net avoHatte notavadatte ref eve latte net eraSetle 1

) B8

) WASHINGTON DC
©bb wdc.us g)3 ©bb-wdcgreenpeace.org bb.wdc.us gl3 smlpv.de us gl 3 www wdc us gl3 ftp wdc us g!3 bb wdc us gl3 1

'. BB

, Green base

©mo 1 greenbase.g!3 @gb greenpeace org pop greenbase.gl3 smfp greenbase g!3 www greenbase g!3 ftp greenbase g:3 bb greenbase g>3 1

| VANCOUVER office ©mail yvr.co gl3 ©yvr greenpeace org popyvrco gl3 smlp yvr.ca gl3 bb yvr ca gl3 net available net erclatte J

| TORONTO office ©moil.yio co gl3 Gyto greenpeace org pop.yto co gl3 smtp yto ca gl3 www yto co gl3 ftp yto ca g!3 bb yto ca gl3
BB SWITZERLAND ©moJ.ch.gl3 Qch greenpeace org pop ch gl3 smtp.ch g!3 www ch g 13 ftp ch g:3 bbch.gl3
LONDON. UK office ©moil uk gl3 ©uk greenpeace org popukgl3 not available not avateb'e not available net avateble 1

BB UK ©bb ukgl3 ©bb-uk greenpeace org bb.uk.gl3 smtp uk.gl3 www.uk.gl3 ftp uk g!3 bb.uk.g’3
SWEDEN office ©mol nordic gl3 ©nord c greenpeace org pop nordic gl3 not enviable not erasable not avetette netavetette J

, BB SWEDEN ©bb nordic gl3 ©bb-nordic greenpeace org bb nordic gi3 smtp nordic gl3 www nordc gl3 ftp nordic gl3 bb nordic gl3
AUSTRALIA office ©mail au gl3 ©au greenpeace org pop ou gl3 not avclatte net era .able not available nclavaJabte |

88 AUSTRALIA ©bb au g!3 ©bb-ou greenpeace org bb.au.g!3 smtp au g!3 wwwcug!3 ftp ou g<3 bb au gl3
. CZECHIA office ©mail cz gl3 ©cz greenpeace org pop.cz. gl3 smtp cz.gi3 www.cz.gl3 bb cz.gQ

RUSSIA office ©mail ru gl3 ©ru greenpeace org pop ru gl3 smfp ru gl3 wwwnj gl3 f»prugl3 bb ru.g!3
VIENNA.

AUSTRIA office

©molat gi3 ©at greenpeace org pop at gl3 net erasable not ova able not eva latte net e.e3ctte

VIENNA.

GP Fundra&ng

©mail if oi.gl3 ©it-al greenpeace org pop if at gl3 smtp if al gl3 www if at gl3 ftp if at gl3 bb if at gl3

BUENOS AIRES,

ARGENTINA

©malargl3 ©ar greenpeace org pop.orgl3 smtp ar gl3 wwworgl3 ftp argl3 bb argt3

SAO PAULO. BRAZIL ©mailbrgl3 ©br greenpeace org pop.br gl3 smlp.brgl3 wwwbr.gl3 tip br gl3 bb br.gl3
MANAUS, AMAZON ©mail amazon gl3 ©amazon greenpeace org pop amazon gl 3 smlp.amazon gl3 www amazon gl3 tp amazen gl3 bb amazon gl3

) AUCKLAND,

NEW ZEALAND

©ma 1 nz gl3 ©nz greenpeace org pop nz gl3 smlp nz.gl3 www.nz.gl3 ftp nz gi3 bb nz gl3

1 BRUSSELS, BELGIUM Gmail be g!3 ©be greenpeace org pop be.gl3 smfp be.gl3 www.be.gi3 ftp be gl3 bb be gl3
PARIS, FRANCE ©mad If gl3 Gfrgreenpeace.org pop fr gl 3 smtp fr gl3 www.fr.gl3 fip fr gl3 bb fr gi3

1 FUI @mo;l i| gi3 @f| greenpeace org pop fj.gl3 smtp.fj.gl3 www.fj.gl3 ftp f| g'3 bb f| gi3
MV Arctic Sunrise GmoJ mvas g!3 ©mvas greenpeace org pop mvas’gl3 smfp mvas gl3 www mvas gl3 ftp mvas gl3 bb m»-as gl3 ’

MV Greenpeace ©mail mvgp gl3 ©mvgp greenpeace org popmvgp g’3 smfp mvgp gl3 ■www mvgp gl3 ftp mvgp gl3 bb mvgp gl3 i
MV AMAZON

Guardian

©moil mvag.gl3 Gmvag greenpeace org pop mvog gl3 smtp mvog gi3 www mvog g!3 fip mvog gl3 bb mvog gi3 i

-___ - - - ____ __ —,
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wdcgreenpeace.org
smlpv.de
http://www.uk.gl3
http://www.cz.gl3
http://www.nz.gl3
http://www.be.gi3
Gfrgreenpeace.org
http://www.fr.gl3
http://www.fj.gl3
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